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Solid state equipment has operational characteristics differing from those of 
electromechanical equipment.  "Safety Guidelines for the Application, Installation, and 
Maintenance of Solid State Controls" (Publication SGI-1.1) describes some important 
differences between solid state equipment and hard-wired electromechanical devices.  
Because of this difference, and because of the wide variety of uses for solid state 
equipment, all persons responsible for applying this equipment must satisfy themselves 
that each intended application of this equipment is acceptable. 

In no event will Rockwell Automation be responsible or liable for indirect or 
consequential damages resulting from the use or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes.  
Because of the many variables and requirements associated with any particular 
installation, Rockwell Automation cannot assume responsibility or liability for actual use 
based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation with respect to use of the 
information, circuits, equipment, or software described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written 
permission of Rockwell Automation is prohibited. 

Throughout this manual, we use notes to make you aware of safety considerations. 

 

ATTENTION:  Identifies information about practices or 
circumstances that can lead to personal injury or death, 
property damage, or economic loss. 

 

Important: Identifies information that is especially important for 
successful application and understanding of the product. 

 

European Union Compliance 

The RAC6181 Computer meets the European Union Directive 
requirements when installed within the European Union or EEA regions 
and has the CE mark.  A copy of the Declaration of Conformity is 
available at the Rockwell Automation / Allen-Bradley Internet site: 
www.ab.com 

 

ATTENTION: The RAC6181 Computer is intended to 
operate in an industrial or control room environment, 
which utilizes some form of power isolation from the 
public low voltage mains.  Some RAC6181 Computer 
configurations may not comply with the EN 61000-3-2 
Harmonic Emissions standard as specified by the EMC 
Directive of the European Union.  Obtain permission 
from the local power authority before connecting any 
RAC6181 Computer configuration that draws more than 
75 watts of AC power directly from the public mains. 

 

 

Important User 
Information  
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Using this Manual 

Read this preface to familiarize yourself with the rest of the manual.  The 
preface covers the following topics: 

•  who should use this manual 

•  the purpose of the manual 

•  contents of the manual 

•  conventions used in this manual 

•  Allen-Bradley support 
 

Use this manual if you are responsible for installing, using, or 
troubleshooting the RAC6181 Industrial Computer.  

 

This manual is a user guide for the RAC6181 Industrial Computer.  It 
gives an overview of the system and describes procedures you use to: 

•  install the RAC6181 Computer in a panel or enclosure 

•  install and remove system components 

•  run the system 

•  troubleshoot the system 

Preface

Who Should Use This 
Manual 

Purpose of this Manual 
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Chapter Title Contents 

 Preface Describes the purpose, background, and 
scope of this manual. Also specifies the 
audience for whom this manual is 
intended. 

1 System Features Shows the different versions of the 
RAC6181 Computer and system features. 

2 Installation  Describes how to install the RAC6181 
Computer in a panel or enclosure. Also 
tells how to connect devices (such a 
mouse/keyboard) to the system.  

3 Initial Operation and 
Setup 

Tells how to start and checkout the 
system.  

4 Adding/Removing 
System Components 

Gives procedures for adding/removing 
memory, add-in boards, hard drive, 
accessory drive, power supply and 
processor board. 

5 Installing/Removing the 
Power Supply 

Gives procedures for installing or 
removing a RAC6181 power supply. 

6 Installing/Removing the 
Hard Drive, Floppy 
Drive, or Expansion 
Bay  

Gives procedures for removing or 
installing a hard drive, floppy drive, or 
expansion bay into the RAC6181 
Computer. 

7 Connecting External 
Drives 

Explains how to connect an external drive 
(such as a CD-ROM) to the RAC6181 
Computer. 

8 Installing/Removing 
Memory Modules 

Gives procedures for installing or 
removing memory modules to the 
RAC6181 Computer. 

9 Replacing the Backlight 
Tubes 

Gives procedures for replacing the 
backlight tubes on the RAC6181 
Computer display.  

10 12.1 in Keypad Bezel 
Operation 

Describes operations specific to the 
RAC6181 12.1 in. keypad version. 

11 System 
Troubleshooting 

Explains how to interpret and correct 
problems with the RAC6181 Computer. 

12 Maintenance Gives procedures for cleaning the 
RAC6181 Computer display, and other 
components. 

Appendix A Specifications Provides physical, electrical, 
environmental, and functional 
specifications. 

Appendix B CPU Specifications 
and BIOS Settings  

Provides information on the CPU card and 
BIOS settings of the RAC6181 Computer. 

Appendix C Using a Touchscreen Provides information on using a 
touchscreen with the RAC6181 Computer. 

 
 

Contents of this Manual 
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The following conventions are used throughout this manual: 

•  Bulleted lists such as this one provide information, not procedural 
steps. 

•  Numbered lists provide sequential steps or hierarchical information. 
 

Allen-Bradley offers support services worldwide, with over 75 
Sales/Support Offices, 512 authorized Distributors and 260 authorized 
Systems Integrators located throughout the United States alone, plus 
Allen-Bradley representatives in every major country in the world. 

Local Product Support 

Contact your local Allen-Bradley representative for: 

•  sales and order support 

•  product technical training 

•  warranty support 

•  support service agreements 

Technical Product Assistance 

If you need to contact Allen-Bradley for technical assistance, please 
review the information in the System Troubleshooting chapter first.  
Then call your local Allen-Bradley representative or contact Allen-
Bradley technical support at (440) 646-5800. 

For additional product information and a description of the technical 
services available, visit the Rockwell Automation/Allen-Bradley Internet 
site at http://www.ab.com. 

Manual Conventions 

Allen-Bradley Support 
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3. Hold the board by the edges and firmly press the board into the 

connector on the processor board. 
 

 

 
Note:  Be careful not to disturb the air flow director.  It is required 

to keep the CPU cool.  The flow director for the 2-slot 
chassis should be routed behind the two add-in card slots 
and extend alongside the CPU heat sink. 

 
4. Align the notch in the board retainer with the threaded hole and 

install the screw.  Hold the notch tightly against the screw before 
tightening.   

Note: If you do not install the retainer tight against the screw, 
you may have problems inserting an adjacent board. 

 
5. Connect any board cables (if required). 

6. Install the top cover.  See Page 4-3. 
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To remove a CPU or add-in card: 

1. Remove the screw securing the board retainer. 

2. Hold the board at each end and carefully rock the board back and 
forth until the edge connectors pull free. 

Note: When removing the CPU card: 

•  Carefully remove all connecting wiring. Make notes 
of the location of all connectors to ensure that you 
can properly reconnect the wiring. 

 
3. Store the board in an anti-static wrapper. 

4. Remove any unused cable associated with the board. 

5. Install a slot cover over the open slot. 

 

 



 

 

Installing/Removing the Power 
Supply 

This chapter provides instructions on how to remove or install a 
RAC6181 Industrial Computer power supply (AC or DC version). 
Removing the power supply involves the following procedures: 

•  Disconnecting the cables from six devices that are connected to the 
existing power supply (this requires partially removing the CPU 
card). 

•  Removing the power supply unit 

•  Disconnecting the touchscreen interface board (if installed) from the 
exterior of the power supply. 

•  Securing the touchscreen interface board (if installed) to the exterior 
of the new power supply 

•  Inserting the power supply into the bay 

•  Reconnecting the connectors 

 

Internal components may be damaged by Electrostatic Discharge (ESD).  
Make sure you wear a grounding strap whenever handling circuit boards, 
power supply, memory modules or other internal components. 

 

ATTENTION:  Wear a wrist strap (well grounded) and 
perform work in a static safe environment. 

Electrostatic discharge can damage the RAC6181 
Computer and components. 

 
Also observe the following precautions: 

•  Avoid touching the cable connectors. 

•  Always handle the power supply by its metal frame. 

Chapter 5

Chapter Objective 

Safety Precautions 
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The power supply for the RAC6181 Industrial Computer accepts an 
input power and provides regulated lower voltages required for all 
internal components such as the processor board, card connectors, and 
chassis fan. 

The RAC6181 Computer has the following power supply options: 

•  AC power version with a 120/240V AC power supply. 

•  DC power version with an 18-32 V DC power supply. 
 

 

ATTENTION:  Review safety precautions before 
proceeding.  Failure to follow proper safety procedures 
could result in severe electrical shock or damage to the 
RAC6181 Computer. 

 
To remove the power supply (AC and DC option): 

1. Disconnect power from the RAC6181 Computer. 

2. Remove the back cover and the top cover.   
 
Refer to procedures in Chapter 4 for details on removing the back 
cover and top cover. 

Important: You must take note of the location of all connectors before 
you remove the existing power supply and cabling, so that 
you can attach the wires from the new power supply. 
Do not disconnect the wiring from the power supply itself 
unless specified.  The replacement power supply comes 
with cabling attached. 

 
3. Follow the wires as they exit the top (output side) of the power 

supply and disconnect the wiring at the connectors of the other 
components (i.e., CPU card, backplane, drives, etc.).   
 
Pull on the connector to remove it: do not pull on the wires. Some 
connectors have a mechanical latch that must be disengaged before 
disconnecting. Make sure you adequately note the location of each 
connector. 

Note: In order to access the large 14-pin connector (P2) on 
the 2-slot backplane, you must remove the top cover 
and partially remove the CPU card and I/O card.  Refer 
to procedures in Chapter 4 for details on removing 
cards. 

 

Installing/Removing a 
Power Supply 
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4. Remove the 4 mounting screws that secure the power supply (2-slot 
chassis shown below). 

 
 

5. Remove the power supply. 

6. Disconnect the cables that connect the power supply to the input 
terminal strip:   

•  With the AC option, disconnect the cables from the bottom of 
the power supply. 

•  With the DC option, disconnect the red and black cables from 
the input terminal strip itself.  Cut the tie strips that secure these 
cables around the fan.  
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To install the power supply (AC option):  

 

ATTENTION:  Risk of Electrical Shock.  Do not use 
screws exceeding 6.35mm (0.25 inches).  Screws that are 
longer than recommended may come in contact with 
voltage sources within the power supply. 

 
1. Connect the input cables to the bottom of the power supply. 

2. Position the power supply in the chassis and secure with the 4 
mounting screws.  Torque screws to 0.7 to 0.9 N-m (6-8 in-lbs). 

3. Connect the power supply cable connectors to the processor board 
and other internal components.  The connectors are keyed so they 
cannot be installed the wrong way, do not force connectors. 

4. Reinstall the CPU and any add-in cards you removed. Refer to 
procedures in Chapter 4 for details on how to install add-in cards. 

 

ATTENTION:  Make sure the air flow director is 
properly positioned.  Failure to correctly install the flow 
director may result in excessive temperatures that can 
damage the RAC6181 Computer. 

 

2-Slot Chassis 4-Slot Chassis  

 
5. Install the back and top cover.  

 

ATTENTION: Carefully engage the pins on the back 
cover and be careful not to push the vibration dampers 
(grommets) on the drive bay out of the sheet metal. 
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To install the power supply (DC option):  

1. Connect the two cables from the bottom of the power supply and 
fuse assembly to the appropriate connectors on the input terminal 
strip.   

The red cable connects to +24V DC terminal.  The black cable 
connects to the 0V DC middle terminal. (For an illustration of the 
DC power connection, refer to Page 2-19.) 

 

 
2. Using the supplied tie strips, secure the cables from the terminal strip 

around the base of the fan. 

3. Position the power supply in the chassis and secure it with the 4 
mounting screws.  Torque screws to 0.7 to 0.9 N-m (6-8 in-lbs). 
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4. Connect the power supply cable connectors to the processor board 
and other internal components.  The connectors are keyed so they 
cannot be installed the wrong way, do not force connectors. 

 

ATTENTION:  Make sure the air flow director is 
properly positioned.  Failure to correctly install the flow 
director may result in excessive temperatures that can 
damage the RAC6181 Computer. 

 

2-Slot Chassis 4-Slot Chassis  

 
5. Install the back and top cover.  

 

ATTENTION: Carefully engage the pins on the back 
cover and be careful not to push the vibration dampers 
(grommets) on the drive bay out of the sheet metal. 

 
 



 

 

Installing/Removing the Hard 
Drive, Floppy Drive, or 
Expansion Bay 

This chapter describes how to install or remove the floppy drive and a 
hard disk from the RAC6181 Industrial Computer and how to install or 
remove the optional expansion bay.    

The RAC6181 Computer supports the following disk drives:  

Disk Drive Catalog No.  

Standard EIDE 3.5” hard disk  6189–HD300 

Large EIDE 3.5” hard disk  6189–HD600 

1.44 Mbyte floppy diskette drive 6189–FD144 

 
When installing or removing a disk drive from the RAC6181 Computer, 
internal components may be damaged by electrostatic discharge (ESD).  
Make sure you wear a grounding strap whenever handling circuit boards, 
memory modules or other internal components. 

 

ATTENTION:  Wear a wrist strap (well grounded) and 
perform work in a static safe environment.  Electrostatic 
discharge can damage the RAC6181 Computer and 
components. 

 
Observe the following precautions:  

•  Always handle the drive by its metal frame.   

•  Store a drive in an anti–static bag when it is not installed. 

•  Avoid touching the cable connectors.   

•  Never disconnect or connect a drive with power turned on. 
 

 

ATTENTION: Mechanical shock will damage a drive.  
Do not drop or bump the drive.   

 
 

Chapter 6

Chapter Objective 

Available Drives 

Safety Precautions 
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These instructions describe how to remove the drive bay and replace the 
hard drive or floppy drive. 

To remove the drive bay:  

1. Disconnect power from the RAC6181 Computer. 

 

ATTENTION:  Disconnect all power from the RAC6181 
Computer before adding or removing components.  
Failure to disconnect power could result in severe 
electrical shock or damage to the RAC6181 Computer. 

 
2. Remove the back cover of the RAC6181 Computer. Refer to 

procedures in Chapter 4 for details on how to remove the back cover.  

3. Remove the drive bay. 

4. Disconnect the ribbon cable connector and the power connector from 
the hard drive and floppy drive. 

5. Remove the hard drive from the drive bay (4 screws). 

 

 

 
 

Installing/Removing a 
Hard Drive or Floppy 
Drive 
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To install the drive:  

1. Install the hard drive in the drive bay (4 screws) 

2. Connect the ribbon cable connector and power cables to the hard 
drive and floppy drive.   

Note: Make sure that the ribbon cable is installed correctly.  
The connector must be positioned so that the red wire 
of the cable is closest to the back of the unit.   

 
3. Position the drive bay into the chassis so that the studs on the chassis 

fit into the grommets on the drive bay.   

 

 

 

ATTENTION: Be careful not to push the vibration 
dampers (grommets) on the drive bay out of the sheet 
metal. 

 
 

4. Install the back cover.  

5. Apply power and verify the operation of the drive.  Refer to any 
additional instructions provided with the drive. 
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Replacing the floppy drive in the hard drive bay:  

1. Perform the steps to disconnect and remove the hard drive bay on 
Page 6-2. 

2. Remove the four floppy drive mounting screws, loosen the hard 
drive mounting screws, and slide the drive from the drive bay.  

Note: The floppy drive and hard drive screws require different 
tool bits. 

 

 

3. Insert the floppy drive into the drive bay and secure the drive to the 
bay with the four mounting screws.  Tighten all eight mounting 
screws to a torque of 0.7 to 0.9 N-m (6-8 in-lbs). 

4. Replace the drive bay using the instructions on Page 6-3. 
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These instructions describe how to install the optional 5.25-in. drive 
expansion bay (6189-1EXPBAY) on the RAC6181 Computer.  The 
expansion bay can be used to house additional components such as a 
DVD-ROM or Read/Write CD-ROM drive. 

Installing the expansion bay involves the following procedures: 

•  Removing the existing back cover 

•  Exchanging the IDE ribbon cable used for the existing hard drive 
with the new cable supplied with the expansion bay option 

•  Installing the drive in the expansion bay  

•  Installing the expansion bay as the new back cover  
 

To exchange the hard drive and floppy drive cables:  

1. Disconnect power from the RAC6181 Computer. 

 

ATTENTION:  Disconnect all power from the RAC6181 
Computer before adding or removing components.  
Failure to disconnect power could result in severe 
electrical shock or damage to the RAC6181 Computer. 

 
2. Remove the back cover and top cover of the RAC6181 Computer. 

Refer to procedures in Chapter 4 for details on how to remove the 
back cover and top cover.  

3. Partially remove the CPU card, I/O card, and any add-in boards so 
that you can access the IDE connector that connects to the hard drive 
and floppy drive. Refer to procedures in Chapter 4 for details on 
removing add-in cards. 

4. Disconnect the IDE ribbon cable from the CPU card that leads to the 
hard drive and floppy drive and connect the replacement IDE ribbon 
cable.  

5. Remove the drive bay. 

6. Disconnect the ribbon cable from the hard drive and floppy drive and 
connect the replacement ribbon cable.  The middle connector 
attaches to the hard drive. 

Note: Make sure that the ribbon cable is installed correctly.  
The connector must be positioned so that the red wire 
of the cable is closest to the back of the unit.   

 

Installing/Removing an 
Expansion Bay 
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7. Disconnect the existing power cable attached to the hard drive. 

8. Connect the power cable to the appropriate connector of the 
Y-shaped power cable provided with the expansion bay kit.  Connect 
the other connector to the hard drive. 

9. Leave hard drive jumper in default setting (Master). 

10. Position the drive bay into the chassis so that the studs on the chassis 
fit into the grommets on the drive bay.   

 

 

 

ATTENTION: Be careful not to push the vibration 
dampers (grommets) on the drive bay out of the sheet 
metal. 

 
11. Reinstall the CPU card and any add-in boards and replace the top 

cover.  
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To install the drive in the expansion bay:  

1. Feed the power cable and ribbon cable through the slot on the 
bottom of the expansion bay. 

2. Connect the power cable and ribbon cable to the expansion drive. 

Note: If you are installing a CD-ROM drive, ensure that the 
jumper setting on the CD-ROM drive is set to "Slave."   

 
3. Secure the drive to the expansion bay using the four screws 

provided. 

To install the expansion bay on the RAC6181 Computer:  

1. Position the ribbon cable and power cable inside the unit to ensure 
that:  

•  The cables do not obstruct the air flow around the internal fan.  

•  The cables will not be pinched when you secure the expansion 
bay cover to the unit. 

2. Secure the expansion bay to the back of the RAC6181 Computer 
using seven of the screws from the original cover. 

 

ATTENTION: Be careful not to push the vibration 
dampers (grommets) on the drive bay out of the sheet 
metal. 

 
3. Apply power and verify the operation of the drive.  Refer to any 

additional instructions provided with the drive. 

To remove the expansion bay:  

1. Disconnect power from the RAC6181 Computer. 

 

ATTENTION:  Disconnect all power from the RAC6181 
Computer before adding or removing components.  
Failure to disconnect power could result in severe 
electrical shock or damage to the RAC6181 Computer. 

 
2. Remove the screws that secure the expansion bay (back cover) to the 

RAC6181 Computer. Refer to procedures in Chapter 4 for details on 
how to remove the back cover.  
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3. Carefully remove the expansion bay. 

Note: Depending on the expansion drive installed, the cables 
connecting the drive may be short.  Be sure not to 
damage the drive or the connections. 

 
4. If necessary, disconnect the ribbon cable connector and the power 

connector from the expansion drive. 

 



 

 

Connecting External Drives 

This chapter shows how to connect an external drive to the RAC6181 
Industrial Computer.  

Note: Refer to Chapter 6 for instructions on installing the optional 
expansion bay for internal drives. 

 
Observe the following precautions when connecting an external drive:  

•  Always handle the media by its case. 

•  Avoid touching the cable connectors.   

•  Remove disks before disconnecting power to the drive. 

•  Avoid exposing the external drive to severe shock or temperature. 

•  Operate the external drive only on a flat surface. 

•  Do not move the external drive while it is operating. 
 

The following are a few examples of external drives: 

•  MicroSolutions Backpack CD-ROM drive (parallel port interface).  
(www.micro-solutions.com) 

•  Imation SuperDisk LS120 drive (parallel port or USB interface).  
Supports 120MB and standard high-density 1.44MB floppy diskettes.  
(www.superdisk.com) 

•  Iomega Zip drive (parallel port or USB interface). Available in 
100MB and 250MB formats.  (www.iomega.com) 

Chapter 7

Chapter Objective 

Safety Precautions 

Sample External Drives 



7–2 Connecting External Drives 

 

Publication 6181-UM001D-EN-P 

This section gives instructions for connecting an external drive to the 
RAC6181 Computer.   

1. Before you apply power to the RAC6181 Computer, connect the 
parallel connector for the external drive to the parallel port on the 
RAC6181 Computer.  For drives supporting a USB interface, 
connect the drive to the USB port on the RAC6181 Computer. 

 

2. Connect the AC plug for the external drive to a power source. 

3. Connect power to the RAC6181 Computer. 

4. Follow the manufacturer’s instructions for loading any required 
software drivers and configuring the RAC6181 Computer to operate 
with the external drive. 

 

Connecting an External 
Drive 



 

 

Installing/Removing Memory 
Modules 

This chapter describes how to add RAM Memory to the RAC6181 
Computer processor board.  Topics include: 

•  Available RAM memory 

•  Guidelines for adding/removing memory modules 

•  How to add/remove memory modules to processor board 
 

The RAC6181 Pentium processor board has one 168–pin socket 
supporting a single or double–sided Dual In–Line Memory Module 
(DIMM): 

Memory Module Catalog Number 

128MB PC100 SDRAM DIMM 6189-DIMM128 

256MB PC100 SDRAM DIMM 6189-1DIMM256 

 
Note: If you use any type of memory module other than a 

qualified Allen-Bradley part, you may encounter problems. 
 

The RAC6181 Pentium III processor board has one 144-pin socket 
supporting a Small Outline Dual In-Line Memory Module (SODIMM): 

Memory Module Catalog Number 

128MB PC133 SDRAM SODIMM 6189-SODIMM128 

256MB PC133 SDRAM SODIMM 6189-SODIMM256 

 
 

Chapter 8
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Available RAM Memory 
(Pentium CPU Card) 

Available RAM Memory 
(Pentium III CPU Card) 
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When adding memory to the RAC6181 Pentium processor board, follow 
these guidelines: 
 

 

•  Use only a standard, unbuffered 168–pin DIMM that conforms to 
both PC-100 and Serial Presence Detect (SPD) compliance industry 
standards. 

•  Use only Synchronous Dynamic Random Access Memory (SDRAM) 
type DIMMs. 

•  BIOS automatically detects memory size and type (i.e., SDRAM vs. 
EDO).  It does not detect parity, however, so this must be manually 
configured by the end-user in BIOS Setup.  The RAC6181 Computer 
ships with ECC-type memory, and the Memory Parity Check feature 
in BIOS Setup is programmed to “ECC” by default.   

•  If a non-ECC DIMM is installed, the Memory Parity Check in BIOS 
Setup must be changed/saved to “Disabled”.  The system will fail to 
boot if ECC is enabled in Setup with a non-ECC DIMM installed.  

•  Use only gold-plated lead DIMMs. 

 

When adding memory to the RAC6181 Pentium III processor board, 
follow these guidelines: 

 

•  Use only a standard, unbuffered, non-ECC 144-pin SODIMM that 
conforms to both PC-100/PC-133 and Serial Presence Detect (SPD) 
compliance industry standards. 

•  Use only Synchronous Dynamic Random Access Memory (SDRAM) 
type SODIMMs. 

•  BIOS automatically detects memory size and type (i.e. PC100 or 
PC133).  Either non-ECC or ECC SODIMMs may be used, but ECC 
parity checking is not supported on this system board.  The ECC 
memory will run in non-ECC mode. 

•  Use only gold-plated lead SODIMMs. 

Guidelines for 
Adding/Removing 
Memory  
(Pentium CPU Card) 

Guidelines for 
Adding/Removing 
Memory  
(Pentium III CPU Card) 
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Internal RAC6181 Computer components may be damaged by 
Electrostatic Discharge (ESD).  Make sure you wear a grounding strap 
whenever handling circuit boards, memory modules or other internal 
components. 

 

ATTENTION:  Wear a wrist strap (well grounded) and 
perform work in a static-safe environment.  Electrostatic 
discharge can damage the RAC6181 Computer and 
components. 

 
Also observe the following precautions:  

•  Always handle the memory cards by the ends not by the memory 
module contacts. 

•  Store memory in a sealed anti–static bag when it is not installed. 

•  Never install or remove memory with the power turned on. 
 

This section gives instructions on how to change an installed memory 
module in the RAC6181 Pentium processor board.  These instructions 
also apply to changing SODIMM memory on the 6181 Pentium III 
processor board. 

To add or remove memory: 

1. Disconnect power from the RAC6181 Computer. 

 

ATTENTION: Disconnect all power from the RAC6181 
Computer before adding/removing components.  Failure 
to disconnect power could result in severe electrical shock 
or damage to the RAC6181 Computer. 

 
2. Remove the top cover of the RAC6181 Computer.  Refer to 

“Removing the Back Cover and Top Cover” on page 4-3 for 
instructions. 

Important: If you have a 2-slot chassis with a Pentium III CPU, you 
must remove the CPU card to install SODIMM memory 
modules.  Refer to “Adding/Removing CPU and Add-in 
Cards” on page 4-4 for complete instructions. 

 
3. The memory module is located at the top of the CPU card, just 

below the top cover. Remove the existing memory module from the 
CPU card. 

a. DIMM modules: remove by pressing down on the retaining 
latch.  

b. SODIMM modules: remove by pulling the edges of the 
connector away from the SODIMM until the SODIMM pops up. 

Safety Precautions 

Adding/Removing 
Memory Modules 
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4. To install a new DIMM, hold the module only by the edges as you 
remove it from its anti–static package. 

5. Position the DIMM so that the small notches in the bottom edge of 
the DIMM align with the notches in the DIMM socket on the CPU 
card.  The retaining latch should be fully disengaged when 
attempting to install a DIMM. 

6. Press down firmly and uniformly on the DIMM to seat it in the 
socket.  The latch should engage in the DIMM locking slot to secure 
the part in place. 

7. Reinstall the CPU card if necessary (Refer to “Adding/Removing 
CPU and Add-in Cards” on page 4-4 for complete instructions), and 
reinstall the top access cover. 



 

 

Replacing the Backlight Tubes 

This chapter describes how to replace the backlight tubes on the 
RAC6181 Computer flat panel display.  Topics include: 

•  Disconnecting the touchscreen cable 

•  Removing the flat panel display  

•  Replacing the backlight tubes 
 

The RAC6181 Computer contains line voltages.  Make sure you 
disconnect all power to the RAC6181 Computer before performing any 
of the operations described in this chapter. 

 

ATTENTION: Disconnect all power from the RAC6181 
Computer before removing components.  Failure to 
disconnect power could result in severe electrical shock 
or damage to the RAC6181 Computer. 

 
Internal RAC6181 components may be damaged by Electrostatic 
Discharge (ESD).  Make sure you wear a grounding strap whenever 
handling circuit boards, memory modules or other internal components. 

 

ATTENTION:  Wear a wrist strap (well grounded) and 
perform work in a static safe environment. 

Electrostatic discharge can damage the RAC6181 
Computer and components. 

 

You will have to uninstall the RAC6181 Computer and place it display 
side down, with the top of the unit facing you.  Make sure to place the 
unit on a clean, flat surface to avoid scratching the display. 

Chapter 9

Chapter Objective 

Safety Precautions 
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RAC6181 Industrial Computer 10.4-in. and 12.1-in. display-only 
versions may come equipped with a touchscreen.  If so, you will have to 
disconnect the touchscreen cable before removing the flat panel display 
and replacing the backlight tubes. 

Disconnecting the touchscreen cable: 

1. Remove the back cover of the RAC6181 Computer.  Refer to 
“Removing the Back Cover and Top Cover” on page 4-3 for 
complete instructions. 

2. Disconnect the touchscreen cable from the touchscreen controller 
board. 

 

ATTENTION:  Make note of Pin #1 on the touchscreen 
cable, and its orientation to the touchscreen board, so that 
you can properly reconnect the cable at the end of this 
procedure. 

 

 

Disconnecting the 
Touchscreen Cable 
(Display-Only Versions) 
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Removing the flat panel display: 

1. Remove the 10 screws that 
secure the flat panel to the RAC6181 Computer chassis. 

 

2. Carefully pull the flat panel display away from the chassis and 
disconnect the following connectors from the flat panel display: 

•  LED connector from the LED board 

•  Power cable attached to the backlight power supply 

 

Replacing the Backlight 
Tubes (10.4-in. Display-
Only Version) 
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3. Lift and pivot the chassis to the left.  If you have a touchscreen unit, 
make sure the touchscreen cable comes out of the chassis without 
becoming snagged and damaged.  Place the chassis on its edge to the 
left of the unit. 

4. On the flat panel display, disconnect the backlight tube connectors 
from the backlight power supply. 

5. Disconnect the display cable from the flat panel display by removing 
the 3 screws holding it to the small printed circuit board on the 
display. 

Replacing the backlight tubes: 

1. Press on the retention clip in the direction indicated by the arrow to 
release the backlight tube.   

Note: There are backlight tubes on either side of the display, 
but only one side has an arrow. 

 

 

 
2. Gently pull the tube out of the assembly. 

3. Slide the replacement backlight tube into the slot until it snaps into 
place.   

Reinstalling the flat panel display: 

1. Reattach the display cable to the flat panel display by gently 
plugging the connector into the small printed circuit board and 
replacing the 3 screws that hold it in place. 

 

ATTENTION:  Do not overtighten the screws holding 
the display cable to the printed circuit board.  Tighten to a 
torque of 1-2 in-lbs. (0.1-0.2 N-m) 

 
2. Reattach the backlight tube connectors to the backlight power 

supply.  
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3. Place the chassis back onto the display assembly while: 

•  Reattaching the LED connector to the LED board  

•  Reattaching the power cable to the backlight controller board 

•  Threading the touchscreen cable (if necessary) back into the 
chassis 

4. Reattach the touchscreen cable to the touchscreen controller board, if 
necessary. 

5. Reattach the display assembly to the unit using the 10 screws. 

6. Replace the back cover of the unit if necessary. 

 

Removing the flat panel display: 

1. Remove the 8 screws that 
secure the flat panel to the RAC6181 Computer chassis. 
 

Backlight Power 
Supply Bracket

 

2. Remove the backlight power supply bracket from the right side of 
the unit.  Lift the chassis, if necessary. 

3. Remove the power cable and backlight tube connectors from the 
backlight power supply (the printed circuit board attached to the 
bracket). 

4. Remove the LED connector from the LED board (the small printed 
circuit board attached to the display assembly). 

Replacing the Backlight 
Tubes (12.1-in. Display-
Only Version) 



9–6 Replacing the Backlight Tubes 

 

Publication 6181-UM001D-EN-P 

5. Pivot the chassis to the left.  If you have a touchscreen unit, make 
sure the touchscreen cable comes out of the chassis without 
becoming snagged and damaged.   

6. Lift and pivot the chassis off of the display assembly and place the 
chassis on its side to the left of the display assembly. 

7. Disconnect the display cable from the flat panel display by removing 
the 2 screws holding it to the small printed circuit board on the 
display (see figure below).  The display assembly is now completely 
free of the unit. 

Replacing the backlight tubes:  

1. Remove the 2 screws holding each backlight tube in place. 

Backlight Screws

Display Cable
Retaining
Screws

Backlight Screws

Backlight
Retaining Tabs

Backlights 
are shaded 
in gray.

 

2. Slide the tube to the right about 1/8 in. (3 mm) and gently pull the 
tube up and out of the assembly. 

3. Insert the replacement backlight tube into the slot and slide it to the 
left until the holes for the screws are aligned.   
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4. Replace the screws that hold the backlight in place.    

Reinstalling the flat panel display: 

1. Reattach the display cable to the flat panel display by gently 
plugging the connector into the small printed circuit board and 
replacing the 2 screws that hold it in place. 

 

ATTENTION:  Do not overtighten the screws holding 
the display cable to the printed circuit board.  Tighten to a 
torque of 1-2 in-lbs. (0.1-0.2 N-m). 

 

2. Lay the backlight tube connectors to the right of the unit and reattach 
them to the backlight power supply 

3. Place the chassis back onto the display while threading the 
touchscreen cable back into the chassis, if necessary.  Make sure that 
you have access to the LED connector and backlight power cable 
after the chassis is in place.  

4. Reattach the LED connector to the LED board and the backlight 
power cable to the backlight controller board. 

5. Place the backlight power supply bracket back into place on the unit. 

6. Reattach the touchscreen cable to the touchscreen controller board, if 
necessary. 

7. Reattach the display assembly and backlight power supply bracket to 
the unit using the 8 screws. 

8. Replace the back cover of the unit if necessary. 
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Removing the flat panel display 

1. Remove the 6 screws that 
secure the flat panel to the RAC6181 Computer chassis. 

Screws securing
flat panel

Retaining screw

Hinged chassis

Flat panel display

 

2. Remove the retaining screw from just below the top hinge and open 
the hinged chassis enough to remove the chassis from the display 
assembly.  Place the chassis on its side to the right of the display 
assembly. 

3. Unplug the following connectors: 

•  Keyboard connector cable 

•  Backlight power/LED cable 

•  Touchscreen cable (if applicable) 

4. Disconnect the display cable from the flat panel display by removing 
the 2 screws holding it to the small printed circuit board on the 
display (see figure on the following page). The display assembly is 
now completely free of the unit. 

Replacing the Backlight 
Tubes (12.1 in. Keypad 
Version):  
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Replacing the backlight tubes: 

1. Remove the 2 screws holding each backlight tube in place. 

Backlight Screws

Display Cable
Retaining
Screws

Backlight Screws

Backlight
Retaining Tabs

Backlights 
are shaded 
in gray.

 

2. Slide the tube to the right about 1/8 in. (3 mm) and gently pull the 
tube up and out of the assembly. 

3. Insert the replacement backlight tube into the slot and slide it to the 
left until the holes for the screws are aligned.   

4. Replace the screws that hold the backlight in place. 

Reinstalling the flat panel display: 

1. Carefully pivot the chassis back into place on the display assembly. 

2. Reattach the following connectors: 

•  Keyboard connector cable 

•  Backlight power/LED cable 

•  Touchscreen cable (if applicable) 
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3. Reattach the display cable to the flat panel display by gently 
plugging the connector into the small printed circuit board and 
replacing the 2 screws that hold it in place. 

 

ATTENTION:  Do not overtighten the screws holding 
the display cable to the printed circuit board.  Tighten to a 
torque of 1-2 in-lbs. (0.1-0.2 N-m) 

 

4. Reattach the display assembly to the unit using the 6 screws. 

5. Replace the retaining screw below the top hinge.  



 

 

12.1 in. Keypad Bezel Operation 

This chapter describes operations specific to the RAC6181 12.1 in. 
keypad version.  The RAC6181 front bezel assembly consists of a plastic 
bezel with overlay and a metal frame assembly that holds the LCD panel 
and associated interconnection circuit boards.  The RAC6181  keypad 
version has removable function key legend strips.  This chapter’s topics 
include: 

•  How to install the keypad legend strips 

•  Keypad Configuration Utility (KCU) software 

 

The RAC6181 12.1 in. keypad versions contain three legend strips – one 
strip for the horizontal function keys located below the display and two 
strips for the vertical function keys located on either side of the display.  
Each of these legend strips can be removed and replaced with custom 
printed versions.  Contact Rockwell Automation for more information on 
how to obtain customized legend strips. 

The standard legend strips shipped with the product are configured as 
follows: 

Horizontal strip F1-F14 printed on exposed side, 
user-writable surface on the reverse side. 

Left vertical strip K1-K10 printed on exposed side, 
user-writable surface on the reverse side. 

Right vertical strip K11-K20 printed on exposed side, 
user-writable surface on the reverse side. 

 

The following replacement legend strips can be ordered from Rockwell 
Automation. Each kit contains one each of the three legend strips – 
horizontal, left vertical, and right vertical strips.  They are configured as 
listed above with text printed on one side and a user-writable surface on 
the other side.  

Part Number Description 

6189-2KEYKIT12 12.1 in. bezel legend strip kit (3 pcs) 

 

Chapter 10

Chapter Objective 

Installing Keypad Legend 
Strips 
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To replace the horizontal legend strip:  

1. Locate the exposed legend strip tab on the lower left side of the 
RAC6181 unit.  

Horizontal Legend
Strip Tab

 

2. Carefully pull on the tab to remove the installed legend strip. 

3. To insert the new legend strip, first slightly cup the strip and 
carefully push it into the bezel slot.  Short pushes will help slide the 
new strip fully into place. 

4. Verify the alignment of the legend strip text with the front overlay 
key windows.  Adjust as needed by pushing or pulling slightly on the 
legend strip tab. 
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To replace the vertical legend strips:  

1. Remove the RAC6181 from the panel. 

2. Remove the 6 adapter plate screws and open the hinged front (page 
9-8). 

3. Disconnect all cables between the bezel and computer chassis. 

4. Close bezel to access the hinges on the outside of the unit.  Remove 
the screw retaining the hinge halves together.  This will allow you to 
separate the bezel from the chassis. 

5. Separate the bezel assembly completely from the chassis. 

6. Disconnect keypad and touchscreen cables from the small 
interconnect board.  This is the circuit board with the two PS2 
connectors extending out the back of the bezel. 

7. Remove the 10 screws securing the metal frame and lift the metal 
frame away from the plastic bezel. 

8. Place the front bezel plastic overlay facedown on a flat surface.  
Take care not to scratch the front overlay or display window.  Locate 
the two exposed legend strip tabs as shown.  

 

9. To remove the legend strips, carefully pull on the exposed tab. 

10. To the insert new legend strip, first slightly cup the strip and 
carefully push it into the bezel slot.  Short pushes will help slide the 
new strip fully into place. 

11. Verify the alignment of the legend strip text with the front overlay 
key windows.  Adjust as needed by pushing or pulling slightly on the 
legend strip tab. 
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12. To reassemble the front bezel assembly, thread the keypad and 
touchscreen cables through the hole in the metal frame. 

13. Reconnect the keypad cable, touchscreen cable, backlight tube 
connectors, and backlight power supply cable. 

14. Reinstall the 10 screws to attach the metal frame to the plastic 
overlay assembly.  Tighten the screws to a torque of 6 – 8 in-Lbs (0.7 
– 0.9 N•m). 

15.  Attach the bezel and install the hinge retainer screw. 

16. Reinstall the 6 adapter plate screws.  Tighten the screws to a torque 
of 6 – 8 in-lbs. (0.7 – 0.9 N•m). 

17. Reinstall the computer in the panel 

 

The RAC6181 Keypad Configuration Utility (KCU) is a PC-based 
program that allows you to modify, view, print, and save keypad 
configurations for the 6181 12.1 inch keypad bezel.  The keypad 
configuration can then be downloaded to the 6181 12.1 inch keypad 
Bezel Interface Controller (BIC) Card using a DOS-based jflash.exe 
utility. 

For each keypad configuration you can: 

•  Enable or disable specific keys or selected key combinations. 

•  Configure the key functionality. 

•  Retrieve, modify, and save key codes associated with specific keys on 
the computer’s bezel. 

The resultant codes for single key are often referred to as the definition 
or mapping of the key.  The collection of all keys’ definitions is 
commonly called the Keypad Configuration. 

Hint: If you modify the Keypad Configuration, you should save 
the new configuration to a Keypad Configuration File 
(*.KY3).  This file can be downloaded into another 6181 
computer to provide the same keypad behavior, or used to 
reload the desired configuration into a replacement 6181 
computer.   

 

Setting Up and Using the 
Keypad Configuration 
Utility Software 
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System Requirements 

The RAC6181 Keypad Configuration Utility is a 32-bit Microsoft 
Windows application that runs on the 6181 computer with Windows 95, 
Windows 98, Windows NT 4.0, or Windows 2000. 

Installing the Keypad Configuration Utility 

The Keypad Configuration Utility software is pre-installed on 6181 12.1 
inch keypad versions.  A backup copy of the application is distributed on 
CD-ROM with the 6181 computer.  Refer to the readme file on that CD-
ROM for instructions on re-installing the Keypad Configuration Utility. 

Configuration Files 

The RAC6181 Keypad Configuration Utility recognizes a file with the 
extension *.KY3 as a 6181 keypad configuration.  Opening a file with 
this extension should launch the RAC6181 Keypad Configuration 
Utility. 

Connecting a Keyboard to the 6181 Computer 

To use the Keypad Configuration Utility, connect an IBM® AT® 
standard keyboard and mouse with PS/2® connectors to the 6181 
computer.  For instructions, refer to page 2-16.  The external keyboard 
connects to the PS/2 port located on the back of the 6181 bezel.  The 
external mouse connects to the PS/2 port located on the 6181 CPU card.  
The PS/2 jumper cable must be installed between the 6181 bezel and the 
6181 CPU card.  This cable connects the 6181 BIC Card to the CPU 
card, so that keypad configuration information can be downloaded into 
the BIC Card.  This cable also connects the multiplexed 6181 keypad 
and external keyboard signals to the CPU card. 
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Using the Keypad Configuration Utility 

To run the Keypad Configuration Utility: 

1. Click on the Windows Start button.  Place the cursor over Programs.  
You will see the Programs submenu. 

2. Place the cursor over Keypad Configuration Utility.  Click on the 
icon. 

3. The Keypad Configuration Utility opens and shows the keypad and 
its current stored configuration.  

The window that contains the keypad configuration stored on the 6181 
computer is named RAC6181 Keypad Configuration. 

 

Figure 1 
12.1” Bezel with Keypad 

You can now: 

•  Modify the keypad configuration and download it to the BIC using 
the DOS utility jflash.exe. 

•  Modify the keypad configuration and save it as a KY3 file. 

•  Recall and modify an existing keypad configuration (KY3 file) and 
download it to the BIC using the DOS utility jflash.exe. 
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Operations available from the menu bar are as follows. 

 
Select commands on 

this menu: 
To 

File Menu  Open, close, and save configuration files, print preview 
and print keypad configuration files. 

Edit Menu  Select all keys or just the programmable keys, 
enable/disable keys, restore default configuration, edit 
single key configurations, and set keypad behavior 
attributes. 

View Menu  Toggle the tool bar or status bar on or off, or view the 
keypad identifiers of the current Keypad Configuration. 

Window Menu  Opens a new window and arranges open windows and 
keypad icons. 

Help Menu  Display a list of help topics or the current version number 
of the 6181 Keypad Configuration Utility. 

 

RAC6181 Keypad Configuration Window 

A keypad configuration appears as a separate window.  Most operations 
are done within this window.  

You can: 

•  enter a description of the Keypad Configuration. 

•  open a saved Keypad Configuration file (*.KY3). 

•  select one or more keys. 

•  enable/disable all or specific keys. 

•  set the default configuration for all the programmable keys or all the 
keys. 

•  edit the definition of the programmable keys. 

− change a programmable key to a new key; e.g. F1  ‘a’ 

− assign a macro string to a programmable key; e.g. F2  
“RAC6181” 
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Entering a Keypad Description 

The text edit box appears near the center of the keypad configuration 
window and allows you to enter a description to identify the Keypad 
Configuration.  The text edit box accepts up to 64 characters.  To edit a 
description, simply click in the text edit box and start typing or editing 
the text. With the cursor in the text edit box, click the right mouse button 
to open the popup menu.  Use the commands on this menu to copy/cut, 
paste and delete selected text.  To select all the text in the description 
box, choose Select All from the popup menu.  The new keypad 
description will be saved to a File when you select Save or Save As … 
on the File menu. 

 

Figure 2 
Text Description 
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Selecting Keys 

The table below shows how to select keys on the keypad.  You must 
select a key before you can enable or disable the key or modify its 
configuration. 

To Select: Do This: The result is: 

Single key  Click the left mouse 
button on the key.   

The selected key is 
highlighted with 
handles. 

Group of keys Click the left mouse 
button and drag the 
selection rectangle 
around the keys you 
want to select.   

The selected keys are 
highlighted with 
handles. 

All keys Choose Select All Keys 
from the Edit menu.   

All keys are highlighted  
with handles. 

All Programmable Keys Choose Select All 
Programmable Keys 
from the Edit menu. 

All programmable keys 
are highlighted with 
handles. 

Multiple Keys Click the left mouse 
button sequentially on 
the desired keys while 
holding down the Ctrl 
key.   

The selected keys are 
highlighted with 
handles. 

 

Enabling and Disabling Keys 

You can enable/disable all or specific keys on the keypad.  By default, 
all keys are initially enabled. 

To disable one or more keys: 

1. Select the key(s) you want to disable. 

2. Choose Enable Key from the Edit Menu or click the right mouse 
button on the key and choose Enable Key from the popup menu. 

A red X appears on the key, indicating that it is disabled and the check 
mark is removed from Enable Key on the Edit menu. 

To enable a key: 

1. Select the disabled key(s) that you want to enable. 

2. Choose Enable Key from the Edit Menu or click the right mouse 
button on the key and choose Enable Key from the popup menu. 

The red X is cleared from the key, and a check mark appears next to 
Enable Key on the Edit menu.  If multiple keys are selected with some 
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keys enabled and others disabled, choosing the Enable Key command 
will enable all the selected keys. 

 

Opening a Saved Keypad Configuration 

To open an existing keypad configuration file: 

1. Choose Open from the File menu or click on the tool bar. 

 

Figure 3 
Open File 

 
2. The dialog shows all keypad configuration files (.KY3) in the “Look 

In:” folder. 

3. Double-click the .KY3 file you want to open or click on a .KY3 file 
and then click the Open button.  A window opens for the selected 
keypad configuration.  The name of the .KY3 file shows in the title 
bar. 

The window titled RAC6181 Keypad Configuration is the 
configuration stored on the 6181.  If this window and all other keypad 
configuration windows are closed, you can reopen the 6181 Keypad 
Configuration from the File menu by selecting Open RAC6181 Keypad 
Configuration from the File menu. 
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Set the Default Configuration for Programmable Keys 

1. Select one or more programmable keys or use the edit menu Select 
All Programmable Keys.  See “Selecting Keys” above. 

2. Choose Set Default Configuration from the Edit menu. 

 

Figure 4 
Set Programmable Key Default 

The selected programmable keys are set to their default assignments.  
The default key assignments are listed at the end of this chapter. 
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Set the Default Configuration for Any Key 

1. Select one or more keys or use the edit menu Select All Keys.  See 
“Selecting Keys” above. 

2. Choose Set Default Configuration from the Edit menu. 

 

Figure 5 
Set Key Default 

The selected keys are set to their default assignments.  Non-
programmable keys are enabled by default.  The default key assignments 
are listed at the end of this chapter. 

To restore the factory defaults on the 6181 keypad configuration, select 
all keys (Edit menu / Select All Keys), then select the Set Default 
Configuration. 
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Editing the Programmable Keys 

To edit the definition of a programmable key: 

1. Select a single programmable key. 

2. Choose Key Configuration from the Edit menu or click the right 
mouse button on the key and choose Key Configuration from the 
popup menu as shown below. 

3. Use the Edit Programmable Key dialog to view the current definition 
and establish a new definition for the programmable key. 

4. Click OK or press Enter to save the definition and close the dialog. 

5. When all programmable keys are defined to your satisfaction, 
download the Keypad Configuration to the 6181 BIC. 

 

Figure 6 
Edit Configuration 
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The Edit Programmable Key dialog lets you modify the definition of the 
selected programmable key.  The definitions are downloaded and stored 
in the 6181 BIC.  Modifying a programmable key is not recommended 
unless required by the application software. 

 

Figure 7 
Select and Edit Programmable Key  

When the Edit Programmable Key dialog box opens, it shows the current 
definition of the selected programmable key.  Nonprintable key codes 
appear in brackets, for example, <F1> or <(L)Shift+F1>.  Modifiers 
appear to the left of a “+” symbol.  (L) or (R) denote left or right 
modifier keys.  The current mode is indicated in the Select Mode 
grouping. 
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Text Edit Box 

The text box at the top of the dialog displays the current definition for a 
selected programmable key.  You can enter a new definition directly into 
the edit box if the characters are printable (e.g., alphanumeric 
characters).  You must enter nonprintable characters from the Add New 
Code list.  While in the text edit box, use Backspace to remove existing 
characters and correct typing errors.  The contents of the Text Edit Box 
are transformed into key codes and/or run commands that are emitted 
when the key is pressed.  Note that one of the more powerful 6181 
keypad features is to perform multiple key codes with a single key press. 

 

Figure 8 
Edit Programmable Key Dialog 

Select Mode 

Determines how the contents of the Text Edit Box will be handled by the 
6181 when the selected key is pressed.  There are 3 modes, established 
by radio buttons. 

1. In Macro/String mode, the key is defined as non-repeating and all 
key codes are sent as a single string when the key is first pressed.  A 
key defined as a Macro/String can submit a sequence of up to 31 key 
presses to the application that is currently in focus.  
 
In the following example, the programmable emits the well-known, 
DOS “DIR command” to the command prompt.  The 6181 command 
prompt application window must be “in focus” on the 6181 before 
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this macro string will work.  The command prompt can be opened 
from the Start menu:  START / RUN. 

  

Figure 9 
Macro/String Mode 
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2. In Make/Break Typematic mode, the key is defined as repeatable at 
the Repeat Rate established by the Keypad Properties Tool in 6181 
Control Panel.  The key “Make” codes are sent when the key is first 
pressed and the “Break” codes are sent when the key is released.  If 
the key is held down, the “Make” codes repeat at the Repeat Rate. 
 
Make/Break Typematic mode is available only for a single key press 
definition including its modifiers, and as such is typically used to 
map a programmable key to a single alpha key.  Thus the keypad can 
emulate a subset of a standard PC keyboard. 
 
In the following example the programmable key emits the character 
‘a’ at the Repeat Rate. 

 

Figure 10 
Make/Break Typematic Mode 

 

Add New Code 

The Add New Code grouping on the dialog is a list of valid keys and 
modifiers that can be assigned to a programmable key.  A modifier (Shift, 
Ctrl, Alt, Win or Win Appl) are enabled for a key code, by selecting the 
appropriate check boxes.  These check boxes are dynamically updated so 
that only valid combinations are allowed.  After selecting a key code and 
modifiers, click the Enter button to display the new code in the Text Edit 
box.  You must click Enter after each new code selection.  Non-printable 
codes are enclosed within ‘<’ and ‘>’. 
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Hints for editing a programmable key definition: 

•  Select (or click on) a code in the Add New Code list. 

•  Under Left or Right, select the Shift, Ctrl, Alt, or Win check boxes to 
enable one or more modifiers for the new code. 

•  Click Enter to display the new code in the text box.  If entering 
multiple codes, click Enter after each code selection or double-click 
each code selection.  The text box is automatically updated. 

•   Type the characters in the Text box as you want them to appear using 
shifted or unshifted characters. 

•   To insert a nonprintable code in the text, select the code from the 
Add New Code list and then click Enter.  The nonprintable code is 
inserted in the text with brackets. 

 


